INSTALLATION

SCANNING PROBE

The CarveWright Scanning Probe opens up the
world of 3D scanning to anyone. Now you can
reproduce original pieces, repair antique
furniture, even copy trim and moldings with
ease. Almost any material can be scanned,
even soft materials, such as clay or wax. Just

plug the probe into the CarveWright, set the
desired scan area, and watch the CarveWright go to work.

The Scanning Probe can be used with either the Quick Change Chuck (QC) or
CarveTight Spindle system. For the CarveTight, simply insert the straight bushing all
the way into the machine spindle and tighten the grab paw just like you would
when using a 1/2" shank bit. If you have upgraded to the CarveTight spindle,
remove the tapered adapter and press the straight bushing down to within 0.25”
of the probe body (See Figure 3).

If you have a QC the Scanning probe will install just like any other bit with a
tapered adapter. Please follow the dire ctions described below. Before installing
the scanning probe into the QC, lift up the front safety cover and make sure that
there are no other bits installed. Next, make sure that the quick release chuck is
cocked and ready to accept the adapter mounted to the probe.

To cock the chuck, place a
thumb on the Z-Truck Grip
Ridge and two fingers on the

Z-Truck Grip
Ridge

Chuck Release Flange. Press up \

on the chuck release flange as
far as possible and release (See

\ Chuck

Figure 4). The flange will snap Release
and stay up when the chuck is y Flange
prepared to receive the probe r~7?\1 @ ||

assembly. Any time difficulty is -

encountered inserting the FIGURE 4: QUICK RELEASE

probe, simply pull up on the CHUCK FEATURES
flange to insure the chuck is cocked. Press the probe assembly into the chuck until
a slight snap is felt. The probe is now secure in the quick change There are two
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possible connector locations for plugging in your scanning probe depending on the
configuration of your machine. For most machines that have an A-series Serial
Number, the probe plugs directly into the Z-Truck mono receptacle.

/Z-Truck ; 7 _
: | \Plug

—~ Mono

Receptacle < | ¢ \
Probe

FIGURE 5: PLUGGING IN THE PROBE IN MOST A-SERIES MACHINES

All C or B-series Serial Number CarveWright machines, and any A-series Serial
Number machines that have been reconfigured, will plug into an accessory
connector found on the left side of the head cover as shown below. Reconfigured
A-series machines have the homing sensor board removed or unplugged. This
configuration requires that a jumper cable be used to span the distance from the
probe cable to the cover connector. A cable clip is loosely attached to the cable to
manage the cable during the scanning operation. This cable and clip are now
provided with the probe at the time of purchase but you ma y need this cable if; 1)
you have an A serial machine, 2) you purchased your probe before November 1,
2008, and 3) the machine has been reconfigured by removing or unplugging
homing sensor board.
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Location of plug for
A Series machines
Cutting Truck - Z

Accessory
Connector \

Jumper Cable /’ sl _ S, )
Cable Clip / i p
Head Casting ' Ny

FIGURE 6: PLUGGING IN THE PROBE IN
MOST B-SERIES MACHINES

To install the probe using the cover connection, simply plug the jumper cable into
the cover connector and slide the cable clip over the front lip of the head casting.
The clip needs to be approximately centered left to right in the machine. Next, plug
the probe mono jack connector into the other end of the jumper cable. Make sure
that the cable clip allows enough slack for the probe to move fully left to right by
pushing the truck to the left/right sides of the machine with your hand. The probe
is now installed.

Since there are two possible locations to connect the probe, the connection
location must be set in the machine’s memory via the Options menu through the
machine keypad. The B-serial number CarveWright machines are configured to the
correct setting at the factory, but this setting must be changed if the homing
sensor board is eliminated or unplugged from the reconfigured A-series machines.
If this setting is not changed, “Scan Area” will be displayed on the LCD screen even
though there is no probe connected. To change this setting, do the following:

1. Insert the card and turn on the machine. “Scan Area: should appear on the
LCD screen.

2. Pressthe “0” (Options) key on the keypad.

3. Using the up/down arrows, scroll down to the number 5, “User Options”
menu item and press ENTER. You can also simply press the “5” key when
the first option appears.
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4. Scroll down to Scan Probe. Make sure it is on “Cover” instead of “Z truck”.
Press ENTER to toggle between the options.
5. Press stop until you get back to main menu. It should say Project Menu.

Insert the probe plug into the jack located on the Z-Truck. If the probe is correctly
installed the CarveWright machine will recognize it when the cover is closed and
power is turned on. The scanning functionality can now be accessed through the
keypad.

Once the machine is configured and turned ON, it will search to see if the scanning
probe jumper cable is plugged into the accessory connector. If it is, the machine
assumes that the user has inserted, or will insert, the scanning probe into the quick
release chuck and disables the spindle motor from spinning. Pressing ENTER at the
“Scan Menu” will move the spindle to the home position. Once at the home
position, the machine will check to see that the probe is plugged in and operating
correctly.

When the probe is at rest (not touching anything), it should be in the electrically
Closed position. If the probe is operating correctly, the LCD will prompt you to “Jog
to the Starting Corner”. If however, the machine detects that the probe is not in
the Closed position, the LCD will prompt you to “Check Probe and Connection” and
will show you the current state of the probe as Open. In most cased this simply
means that the probe is not plugged into the jumper cable correctly. Check all
connections and move the tip of the probe around watching to see if the state
displayed on the LCD changes to Closed. If you cannot resolve this issue by
plugging and unplugging, please call CarveWright service at 713-473-6572.

When removing the jumper cable remember to depress the release latch before
pulling it free. On some machines the latch may be on the bottom of the
connector.

/
Release Lever

FIGURE 7: PLUGGING IN THE PROBE JUMPER CABLE
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PLACING
OBJECT ON A
SCANNING SLED

Vertical
Rails

Important Note: It is recommended that you unplug your flexshaft from the
spindle if you are doing significant scanning. It makes for more consistent scans. Be
sure to always follow the directions when reassembling the flexshaft so that you
do not bind the flexshaft core and damage the machine.

Because most objects that will be scanned are not suitable for scanning directly
they will have to be placed onto a fixture called a scanning sled before proceeding
(not included with purchase). The scanning sled should be designed so that the
CarveWright can easily feed it through the machine and so that the scanning probe
has the proper clearances to function.

Piece to be

Scanning
Sled Bed ~ | / Scanned

FIGURE 8: SCANNING SLED

The dimensions of the sled can vary but the maximum width is 14.5” and the
maximum depth is 2.25” from the mounting surface to the top of the rails. There is
no maximum length but any sled over 3 feet long will require additional stand-
alone outfeed support rollers. The support rollers should be adjusted properly to
avoid letting the sled sag or rise, as any transition going on and off the rollers will
be reflected in the scan data.

The vertical rails must be at least as high as the object being scanned. If the object
is taller than the vertical rails the machine or object can be damaged.

The maximum height that the scanner body can clear is 1 inch. If the object to be
scanned is taller than 1 inch in any location, check for possible interferences
between it and the probe body. Interference is possible if there is a 1 inch tall point
in the object within 1 inch of a portion of the object that lies at a depth near the
mounting surface.
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INSERTING THE
SCANNING SLED

The scan object can be mounted to the sled with any number of adhesives. Hot
glue works well, as does double sided tape. It is important that the scan object be
rigidly mounted. Any movement during scanning will produce poor scan data. It is
also suggested that the mounting surface of the sled be very smooth and hard (like
Formica). This hard surface makes mounting and removing the scan objects quick
and easy.

The CarveWright will require that the sled be kept under rollers at all times so
make sure that the object being scanned is at least 3.5 inches from either end of
the sled. The scan object must also be at least 1 inch from either vertical rail to
clear the body of the probe.

A/
N 4
Adding a grid pattern to the mounting surface of the sled surface makes
positioning the scan object very easy.

For the purposes of this manual we will assume that all pieces being scanned will
be mounted to a scanning sled. Proper installation of the scanning sled is critical to
the performance and continued operation of the scanning probe. To properly
insert the sled:

1. Press down on the sliding guide plate release lever and move the sliding
guide plate to the right so that it will clear the width of the sled.

2. Check the bottom of the sled for features that will make it unusable in the
machine. The bottom surface of the sled where it contacts the squaring
plate must be flat and level for a width of at least 3/8 inches along the
bottom edge to allow the Board Tracking Sensor to accurately calculate the
position of the workpiece at all times (see Figure 7).

3. Lay the sled on the traction drive so that it is centered lengthwise under
the head.

4. Push the sled firmly up against the squaring plate.

5. Gently push the sliding plate up against the inside edge of the sled. DO
NOT push the sliding plate against the sled with significant force. The
sliding plate is used to guide the sled and is not intended to lock the piece
in position.

6. At this point it is critical that you assure that the sled can travel freely in
and out of the machine along its entire length without binding or
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encountering significant drag. Do this by moving the sled in and out of the
machine by hand, while laying flat on the traction drive.

WARNING: Do not attempt to load a sled that varies in height by more
than 1/16” along its entire length. This condition could bind the machine
and damage the traction drive.

WARNING: Do not attempt to load a sled that does not have parallel
sides. This condition can bind the machine and damage the traction
drive.

7. Lower the head by turning the head crank handle counter-clockwise until

the clutch clicks several times (at least 5 clicks recommended). The clutch
is intended to load the sled against the traction drive with consistent force.

(1N Sliding Guide Plate

Traction Drive

. =% ) Sliding Guide Plate
Squaring Plate\ o A /) / Release Lever

!l..;)

Board Tracking
Sensor

Raird Sensor Detail Release Lever Detail

FIGURE 9: SCANNING SLED
INSERTION DETAILS

8. Rotate the head-locking lever outward into the locked position. The sled is
now secure.
9. Make sure that the top safety cover is closed before proceeding.
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JOGGING THE
SCANNING
PROBE

FIGURE11: CARVEWRIGHT

INPUT KEYPAD

SETTING THE
SCAN AREA

Before the CarveWright can begin to function, the CarveWright memory card must
be installed. With the power off, push the memory card gently into the memory
card slot until it stops, making sure the label is up. Once the sled is installed and
the cover is closed, proceed to turn the machine on.

At this point, control is accessed through the Keypad and LCD Display. The scan
utility will automatically sense the scanning probe and will display the Scan Area

menu item.

o@o.

oNTRay,
@)

When the Scan Area item has been selected from the display menu, the

CarveWright will send the head to the home position. The display will then prompt
for the user to specify the starting corner of the scan area.

The scan area is determined by specifying any two diagonal corners of the scan
object. The user will need to jog the probe tip to the first corner point using the
arrow keys. This is accomplished using the up and down arrows on the keypad to
move the truck across the width of the sled (near to far), and the left and right
arrows to move the sled along its length (left or right).
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SETTING THE
SCAN OPTIONS

M, Holding an arrow key down results in a fast movement.
Precise final positioning is accomplished using short bumps
on the key.

Once the probe tip has been jogged to the desired corner location press ENTER.
The probe tip will now slowly lower until the tip touches the surface. Verify that
this is the correct location and press ENTER again. You can continue to tweak the
tip location if it is desired before pressing ENTER. Repeat these steps for specifying
the second corner.

Once both corners have been specified the display will show the Scan Options
menu. The current scan quality will be shown in parentheses. The Scan Options
menu has three options: 1) Proceed with Scan, 2) Change Quality, and 3) Set Max
Depth. If you wish to continue with the scan at this point select option one,
Proceed with Scan.

If you wish to change the quality setting select option two, Change Quality. Use the
up/down arrow keys to find the desired quality and select ENTER to confirm.
These quality modes affect the step size for each point measurement taken. The
higher the quality mode selected, the smaller the step size. The Best setting step
size is .010”, the Normal setting step size is .020” and the Draft setting step size is
.040". It is recommended that scans be performed at the highest possible quality
setting if time permits.

\'7,  The machine will check the memory card to verify that there is enough
space to store all of the scan information. An empty memory card can
hold approximately 2.2 ft2 of Best quality mode scan data. If the

message Scan Too Large For Card appears on the display then there is not enough
room to store the proposed scan. Options to correct this situation are to reduce
the size of the scan area or delete existing information on the card using the Flash
Manager in the CarveWright Design Software.

After the quality mode has been confirmed the CarveWright display will show the
Scan Option menu again. There are instances where the maximum depth of the
scan will need to be limited. For example, in some scanning probe, this can cause
the body of the scanner to impact the object and stall the scan. The Set Max Depth
option allows the user to put a floor on the depth that the probe tip will reach. The
procedure for setting the max depth works very similar to setting the corners of
the scan area. Identify the desired max depth on the scan object surface. Jog the
probe tip to a point directly over this location and press ENTER. At the chosen
location the probe will lower until it makes contact with the surface. By default this
depth will now be the maximum scan depth. If this depth is acceptable select
ENTER otherwise reposition the probe tip and repeat.
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ACCESSING THE
SCAN DATA

GENERAL TIPS
AND HELPFUL
REMINDERS

Once a max depth has been confirmed the display will prompt the user to Use
Selected Depth or Apply Offset. If the Apply Offset option item is chosen, the user
is prompted to input a numeric offset using the keypad. Select ENTER to proceed
or STOP to cancel the offset. The entered offset will be added to the already
confirmed max depth. Once the desired settings have been set, proceed with the
scan by selecting Proceed with Scan. The CarveWright will begin to scan the object.
The scanning probe tip will follow along the object contour, mapping the 3-D
coordinates of the surface as it proceeds. The height map information is stored
onto the memory card for future retrieval by the scanning software. A real time
scanning completion estimator will be displayed on the LCD and provides an
estimate of how much of the current scan is completed.

WM/, Atany point during operation the CarveWright machine can be stopped
by pressing the STOP key or by lifting the cover. If desired the machine
can be restarted by closing the cover and pressing ENTER. The machine

will resume scanning at the point where it was stopped. If you press the stop
button a second time the scan will be aborted so be careful when restarting your
project.

WARNING: Never remove the memory card from the machine while it is on.
Doing so can result in damage to the workpiece.

When the scan is completed the LCD Display will show a prompt to set another
scan area. If you do not wish to produce another scan, turn off the machine, lift the
top safety cover, release the head lockdown lever, and crank the head up to free
the sled. The sled can then be removed.

Remove the CarveWright memory card and place it into the CarveWright memory
card programmer. Open the CarveWright Design software and access the scan data
by selecting the Download Scan menu item on the File menu.

MAXIMUM SCANNING DEPTH is 1.0 inch. Scanning objects deeper than this can
damage the probe or produce poor quality scans.

ALL MOTORS ARE DISABLED when the front safety cover is open. The cover must
be closed before the machine can proceed.

USE A SUPPORT FOR LONG PIECES TO BE SCANNED AND ALSO FOR SCANNING
SLEDS. To minimize the risk of over stressing the machine, use sturdy roller stands
(notincluded) for support when scanning long pieces more than 36 inches in
length.
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WHEN LOADING THE PIECE TO BE SCANNED, there are several critical checks to
make before proceeding.

e Do not attempt to load a piece to be scanned (or sled) that has a
significant taper to the sides. A tapered workpiece will bind between the
sliding plate and the squaring plate and will damage the traction drive.

e Do not attempt to load a piece to be scanned (or sled) that varies in
thickness by more than 1/16” along its entire length. Using a workpiece
with a larger thickness variation than 1’16” can lead to damage to the
machine.

e Always make sure the Board Tracking Sensor that contacts the bottom of
the workpiece (or sled) has a smooth, even surface to follow. This means
that the bottom edge area of the workpiece adjacent to the squaring plate
is clean, smooth, and even for a width of at least 3/8 inch along the full
length of the workpiece.

e Warped, bowed, or cupped pieces should be used only if this condition is
minor and if the Board Tracking Sensor can follow it.

MAKE SURE THAT THE HEAD LOCKING LEVER IS RELEASED after finishing the scan.
If the locking lever is not released the head will not move up and down. The lever
is in the locked position if it is rotated out from the face of the machine. It is in the
released position if it is flush to the front face of the head.

SMALL PIECES TO BE SCANNED MUST ALWAYS USE A SCANNING SLED. Any piece
to be scanned smaller than 1.5 inches wide x 0.25 inches thick x 7 inches long will
require it to be placed on a scanning sled.

TO LOCATE THE MACHINE TOTAL SCAN-TIME, use the Options shortcut key on the
keypad to access the information.

TO LOCATE THE SERIAL NUMBER, use the Options shortcut key on the keypad to
access the information.

UNPLUG THE FLEXSHAFT, for more consistent results.
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BUILDING A Use these drawings to build a scanning sled.

SCANNING SLED
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ROTARY JIG

CARVING IN THE ROUND: A REVOLUTIONARY IDEA

The Rotary Jig, and accompanying software, enables the design, import,
and carving of turned projects. It's like a lathe, but with carvings. The
rotary software, included with purchase of the jig, shows the carved
round piece along side a flat board where the design is manipulated. The
jig is simple to use. Load your material in, calibrate the jig, and carve your
pieces in the round. With the STL Importer add on, you can even import
STLs directly into the rotary format. Now this is truly revolutionary.

Follow the guide on the following pages and watch the tutorial videos
online for more information.

http://www.carvewright.com/accessories-page/rotary-jig/
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WOODWORKING SYSTEM

Rotary Jig

Basic Instruction

04/2014

Congratulations on your purchase
of the Rotary Jig accessory for
your CarveWright machine. We
hope you will enjoy your new
capability of carving in the
round!

This document outlines the basic
setup and use of the Rotary Jig for rotary
carving. Visit carvewright.com to view
“how-to” video tutorials for creating

your own custom rotary
€

projects using the Designer
software and software add-on
enhancements.

You will need to own the CarveWright

1/8 " Long-Reach Carving Bit for use with
your Rotary Jig. This bit is specifically
designed for the rotary jig and for deep
carving of “flat” projects. (fig. 1)

ARY CARVING!

Rotary Jig and Material Setup

Rotary Carving Accessory for CarveWright™ CNC Machines

1 inch
min diameter

4.25 inch —
max diameter

Stock shape can be:

() O

Corner Cut Round

Square

1/8 " Long-Reach Carving Bit

Jig Material Size Requirements

Material Diameter Specifications

The jig requires material with a minimum
diameter size of 1 "up to a maximum of
4.25" diameter. (fig. 2a, 2b)

Material Length Specifications

The jig requires material with a minimum
length of 5.5" to a maximum length of13"
(fig. 2¢)

For outer diameter,
measure from the corners

. (outer dia. never to exceed
U AP 4.25" nor be less than 1")

IMPORTANT:
Measure across the widest diameter of your
stock. This OUTER diameter is what you
will need to remember when it comes time
to input the diameter measurement at the
machine during project runs.

(cont.)

CarveWright Tutorial
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Rotary Jig and Material Setup

Jig Material Size Requirements (cont.)

13 inches - Maximum length

5.5 inches - Minimum length

Mounting the Material Into the Jig

Cut your material to the appropriate length, then mark
the center-point on both ends. A clear plastic center
marking template is handy for this (especially for round
stock), but not absolutely necessary. (fig. 3a, 3b)

Drill holes at the center mark on each end about 2"
deep using a 7/32" drill bit. (fig. 3¢)

Page 2

(cont.)

Thread the stock onto the screw chuck. (fig. 3d)

fig. 3d

Slide the end panel to the stock and align the tailstock
point into the drilled hole. (fig. 3e)

\
_>"

Tighten the wing nuts “finger tight” so it holds the
stock snugly, but can still rotate freely. (fig. 3f)

\

(cont.)

CarveWright Tutorial
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Rotary Jig and Material Setup (cont.)

Mounting the Material Into the Jig (cont.)

On the belt drive end of the jig, you will see a trough
on the outside metal hub. This allows access to two
countersunk holes and the end of the material. Rotate
the material to line up with one of the holes. (3f)

fig. 39

Drive a #6 x 11/4" coarse-thread screw through this
hole and flush with the countersink. (fig. 3h)
- . -

Rotate the material again to line up the second hole.
Drive in another screw. These screws secure the
material from slipping during the carving process.
Check that the material rotates with no binding of the
screw heads against the plate.

Confirm the
secured stock
and mechanism
rotates with

no binding after
driving in both
screws

Placing the Jig Into the Machine

The jig has two tabs extending from the bottom of each
end panel. These tabs fit into the U-shaped slots of the
stationary squaring plate (keypad side of the machine)
and the moveable sliding plate. (fig. 4a)

T

The jig’s tabs fit into the two plate slots

Move the sliding plate all the way to the right, then
raise the head just enough to be able to maneuver the
jig into the machine. Don’t raise the head too high or it
will lock in place and you’ll need to manually lower it.
(fig. 4b) 3

Raise head and
place the jig into
the machine with
the gear drive on
the keypad side
of the machine

m&.

=Y

Position the jig so the tab rests in the stationary plate
slot. Move the sliding plate against the jig so that the
other tab rests inside that slot, as well. The sliding plate
edge should be right up against the jig roller bearings
which rest on the traction belt. (fig. 4c)

Each tab fits into
a plate slot on
each side of the
machine

(this photo shows
the tab resting in the
sliding plate slot)

m (cont.)
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Rotary Jig and Material Setup

Aligning the Jig

With the jig properly placed (the jig side panels are
elevated slightly ABOVE the guide plates of the
machine) crank down the head of the machine to hold
the jig securely. You will notice a groove on top of each
side panel of the jig. These are alignment references.
(fig. 5a)

Alignment
Groove

Insert a bit into the chuck. To check alignment,
carefully lower the chuck/bit to each mark on both
sides of the jig by hand. The tip of the bit should be in
alignment with both grooves. (fig. 5b)

Carefully lower the
chuck/bit by hand

into the groove on |
top of each jig side ;
to check alignment —8

e W
.

If the bit doesn’t line up with the marks, take note of
how much it is “off” and remove the jig. Adjust one or
both of the metal tabs on the side panel(s) by loosening
the screws and repositioning the tab(s). Reinsert the jig
into the machine and check alignment again. Repeat
the process, if necessary, until the jig marks are aligned
with the tip of the bit. (fig. 5¢)

Page 4

(cont.)

Calibrating the Jig

The jig must be calibrated before each rotary carve.
Load your stock into the jig and insert the jig into the
machine, check alignment, then follow these steps:

* Insert the carving bit and close the cover.

* Turn on the machine and press “0” on the keypad to
access the Options Menu, then press “6” to access the
Configuration Menu, then press “7” to access the
Rotary Cal

* To begin calibration, press the green “Enter” button
(there will be a brief Homing routine, then the Jog To
Touch menu appears on the LCD panel)

* Use the arrow keys on the keypad to jog the bit to
your chosen location on the stock. The side-to-side
arrows rotate the stock. The up/down arrows move the
bit across the stock. T

(fig. 6a)

* Now, open the cover, then “jab” the chuck/bit up and
down by hand into the stock to create a visible divot
mark. After a clear divot mark is made, raise the
chuck/bit back up out of the way of the jig. (fig. 6b)

This divot mark will be used for the next step of the
calibration.

(cont.)

CarveWright Tutorial
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Rotary Jig and Material Setup

Calibrating the Jig (cont.)

* Now that you’ve made your reference divot mark and
raised the bit up out of the way, go ahead and press the
green “Enter” button. The machine will rotate the stock
three times and then stop. You should see your divot
mark. Lower the chuck/bit by hand to see whether the
tip of the bit is still centered with your mark. (fig. 6¢)

A i

If they do not line up, use the arrow keys to reposition
the bit to match the reference mark (and lower the bit
by hand, to confirm alignment). Once aligned, press the
green “Enter” button again. The LCD screen will now
display the “old” and the “new” settings, and the option
to 1) Keep or 2) Abort. You want to press “1” to keep
the new setting. The stock will rotate again and you can
observe if the bit aligns with the mark this time. (6d)

Did:9z4.2
1) Keer

58, H} 213.

Press “1”
to Keep

It is advised to run the calibration at least twice in order
to ensure a consistent result. If the results are still
inconsistent (i.e., the bit and mark won’t align), then
it’s most likely the machine’s head pressure is too low
or the jig is not positioned properly. Sometimes a little
extra “push” with your hand while cranking down the
head can increase the head pressure enough to get a
good calibration, so try that first.

Once calibrated, you are now ready to run your project.
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(cont.)

Running A Rotary Project

* From the Project Menu, select your rotary project,
then press “Enter”

* The machine will measure the length of your stock to
make sure it is long enough for your project

* Next, the machine will prompt you to input the
stock’s diameter (the initial number displayed is simply
the minimum diameter required for the project). The
stock’s OUTER diameter is what you need to specify.
(see pg. 1, fig. 2b)

* Use the up/down arrow keys to select the stock’s
OUTER diameter. Select the next higher diameter if
there is no exact match. Aside from the initial diameter
display, the diameter choices are in .25" increments.
Press ENTER after making your selection.

Use the arrow
keys to scroll
through the

diameter choices

* You will then be prompted for the bit, as usual. Insert
the bit and press ENTER. The machine will proceed
with Homing/Bit Find and then run your rotary project!

For additional information and resources, please visit:
http://www.carvewright.com/support-page/getting-
started/tutorials/

There are also several Rotary sections available at the
CarveWright Community Forum you may find helpful.
Please visit: http://forum.carvewright.com/forum.php

(cont.)
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Additional Resources
RESOURCES...

There are numerous resources for the Carve Wright/CompuCarve owner to make their experience with these
machines much more enjoyable.

Every owner should join the CarveWright User Forum (http://forum.carvewright.com/forum.php) where fellow
users share their experiences and knowledge with these machines on a daily basis. It is a FREE service that you
will surely appreciate. A handy Search Feature helps you find answers to any questions you may have.
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SANDING Mors

Sanding mops are a great way to speed
up and simplify the sanding and
cleaning of your carvings. Attach itto a
drill press or another high speed motor,
and quickly polish your projects
without removing your carved details.
It will literally save you hours of
tedious, hand sanding work. With two

grits and two sizes, no matter the
project, we’ve got you covered. We also have sandpaper refills for when you wear
them out from all the great projects you are making.

ASSEMBLY The CarveWright sanding mop is very easy to assemble into a number of different
configurations to best suit the job at hand. By adding spacers between the layers
you can change the “softness” and “aggressiveness” of the sanding.
Fundamentally, the sanding mop is made up of sets of top and bottom facing strips
of sandpaper that are set 452 from each other. No matter which size of mop you
have purchased, you will want to start by building sets of two sanding strips lined
up with the grit sides facing away from each other. Then you will want to take two
of these sets and place them at 902 to each other to form what is called a sanding
unit (Figure 1). Each sanding units are then assembled on to the mandrel at 45
degrees to the last sanding unit. Continue crisscrossing sanding units (Fig. 1) until
you reach the mop thickness you desire.

‘

Q

DOUBLE MOP KIT

#— STABILIZER

<+ GRIT S

+— GRIT4

MANDREL

FIGURE 1

The stiffness and aggressiveness of your sanding mop can be varied by changing
the way you assemble the supplied stabilizers (thin white plastic disks) and the unit
spacers (black rubber washers) into the sanding units.
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For Maximum stiffness: Use the stabilizers only (with the sanding units in
between). This configuration is useful for sanding routed edges.

For Medium stiffness: Use the stabilizers in addition to the spacers. This will
reduce the aggressiveness and stiffness of the sanding mop, allowing it to get into
the carved detail more efficiently. Note: If you wish to use the spacers on the small
sanding mop place a spacer on the mandrel after every two sanding units (8
sanding strips) as opposed to after every sanding unit as done on the large sanding
mop.

For Minimum stiffness: Use only the spacers to further increase the softness of the
sanding mop. This configuration works very well when sanding fine details in deep
carvings.

If you wish to use the stabilizers in your configuration, begin the assembly by
placing one stabilizer on the mandrel and end the assembly by placing the
remaining stabilizer on the mandrel directly before the nut(s). Tighten the nut and
place the sanding mop securely in a drill, drill press, lathe, bench grinder. Before
you begin using your sanding mop you must separate the splits in the sanding
strips by pressing a corner of a piece of hardwood in to the sanding mop while it is
spinning.
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